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Cavo breakout di Duet

Manuale dell'utente 
di Duet

CD software Apogee

Cavo FireWire da 1 m

Contenuto della confezione

Duet

Nella confezione Duet devono essere inclusi gli 
articoli seguenti: 

Duet•	
Cavo FireWire da 1 m•	
Cavo breakout di Duet•	
CD software Apogee•	
Manuale dell'utente di Duet•	
2 Adattatori femmina da presa  •	
mono 1/4 “ a RCA 
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Presentazione di Duet

Livello di ingresso  
e uscita

 Questi LED 
visualizzano il livello 

dell'ingresso o dell'uscita 
selezionato	con	il	codificatore.

 

Porta FireWire
Mediante il cavo FireWire in 
dotazione, collegare il Mac 
qui – Duet è alimentato dal 
collegamento	FireWire.

La manopola codificatore
Impostazione dei livelli in 

tutta	semplicità.	Premere	il	
codificatore	per	selezionare	

un livello di ingresso o uscita 
da impostare, quindi ruotare la 
manopola per ottenere il livello 

desiderato.

Cavo breakout di 
ingresso/uscita
Mediante il cavo breakout in 
dotazione, collegare microfoni, 
strumenti	e	uscite	di	linea	qui.

Uscita cuffie 
Collegare	le	cuffie	qui.

Alimentazione phantom
Questi LED indicano che 
l'alimentazione phantom 
a 48 volt è attiva sulle 
connessioni  .
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Guida rapida

Requisiti di sistema

Mac	G4	1GHz	o	superiore,	CPU	PPC	o	Intel,	1	GB	di	RAM	minimo,	2	GB	consigliati,
OS	X:	10.4.11	o	successivo	installato,	10.5.3	o	successivo	caldamente	consigliato.

Installare il pacchetto software 
Apogee
Inserire il CD in dotazione nell'unità ottica 
del Mac, fare doppio clic sull'icona “Duet 
Software Installer” e seguire le istruzioni 
sullo	schermo.	Al	termine	dell'installazione	
verrà	richiesto	di	riavviare	il	Mac.

   

Collegare il cavo FireWire
Dopo aver riavviato il Mac, collegare 
la porta FireWire di Duet a una porta 
FireWire 400 sul Mac mediante il cavo in 
dotazione.	

Se il Mac è dotato solo di porte Firewire 
800, collegare Duet mediante un cavo da 
FW400	a	FW800.	Si	osservi,	in	questo	
caso, che la porta FW800 funziona alla 
velocità	della	porta	FW400.

 
Poiché	Duet	è	alimentata	attraverso	
il collegamento FireWire, il LED OUT 
dovrebbe	accendersi	immediatamente.

2

1
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Guida rapida

Scegliere Duet come ingresso 
e uscita audio del Mac  
  
Dopo aver collegato Duet al Mac, 
verrà	visualizzata	la	finestra	di	
dialogo	illustrata	a	sinistra.	Fare	
clic su Yes per scegliere Duet for 
Mac	sound	output	and	input.

Questa selezione può essere 
inoltre eseguita nel riquadro 
System	Preferences	>	Sound	>	
Output .
  

            
Collegare le cuffie
Collegare	ora	un	paio	di	cuffie	
all'uscita	cuffie	di	Duet,	aprire	
iTunes e avviare la riproduzione 
di	un	brano	audio.	 
La riproduzione dovrebbe 
essere	udibile	nelle	cuffie	
collegate e visualizzata sui 
misuratori del pannello superiore 
di	Duet.	

4

3
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Uso di Duet con GarageBand 
                4.0.0	o	successivo	consigliato
 

In	GarageBand,	scegliere	GarageBand	>
Preferences,	fare	clic	sull'icona	Audio/Midi	e	
impostare Audio Output e Audio Input su Duet.
Fare clic sull'icona Advanced e impostare Audio 
Resolution su Better o Best.

Scegliere	Track	>	New	Basic	Track...

Fare doppio clic sul titolo della nuova traccia 
per visualizzare il riquadro Track Info; in questo 
riquadro, impostare Input Source su Mono 1 
(Duet); impostare Monitor su On.

 Per	aprire	il	pannello	di	controllo	Apogee	Duet	di	
Garage	Band,	fare	clic	sul	pulsante	Edit		  
accanto	al	menu	Input	Source.

Collegare il cavo breakout in dotazione 
alla connessione I/O di Duet, quindi 
collegare un microfono al connettore 
XLR IN-1.

 

Fare clic sul centro del 
codificatore	del	pannello	
superiore	finché	non	
si accende il LED 
IN-1, quindi ruotare la 
manopola per ottenere 
un livello di registrazione 
appropriato sulla traccia 
abilitata	alla	registrazione.

Si è ora pronti a registrare!

5
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Uso di Duet con Logic Pro/Express
 8.0.2	o	successivo	consigliato

 
Nel	menu	Logic	Pro,	scegliere	 

 Preferences	>	Audio.	Fare	clic	sulla	
scheda Device, quindi sulla scheda Core 
Audio.

 

Nel riquadro Core Audio, selezionare 
Duet	nel	menu	Device.	Selezionare	128 
nel	menu	I/O	Buffer	Size.	

 Scegliere	Audio	>	I/O	Labels	nel	menu	
Options.	Fare	clic-opzione	sul	primo	
pulsante di selezione sotto la colonna 
Driver’s	I/O	Labels.	A	questo	punto,	le	
etichette hardware di Duet appaiono 
nelle selezioni di ingresso e uscita della 
sessione	Logic.

  

 Per	controllare	Duet	direttamente	dalla	
sessione

 Logic,	scegliere	Options	>	Audio	>	Open	
Apogee	Control	Panel	nel	menu	Options.

 Se si utilizza un'altra applicazione audio 
compatibile CoreAudio, utilizzare il 
software Maestro di Apogee (installato 
nella	cartella	Applications	nel	Passo	1)	
per	controllare	Duet.

6
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Funzionamento

È	possibile	modificare	con	facilità	le	impostazioni	di	Duet	con	il	codificatore	del	pannello	
superiore	o	con	i	numerosi	pannelli	di	controllo	del	software	descritti	a	pagina	10.	Sebbene	
siano possibili diverse opzioni, è possibile scegliere i controlli hardware e software più 
adatti	alle	proprie	specifiche	esigenze.	Gli	utenti	di	Logic	Pro,	ad	esempio,	possono	
scegliere	di	regolare	i	livelli	con	il	codificatore	del	pannello	superiore	di	Duet	e	modificare	le	
impostazioni	statiche	(come	la	selezione	degli	ingressi	o	la	fase)	dall'Apogee	Control	Panel	
che	si	trova	in	Logic	Pro	8.	Per	comodità,	molte	impostazioni	possono	essere	controllare	
da	più	pannelli	di	controllo.	La	tabella	a	pagina	9	riporta	le	impostazioni	e	le	funzioni	che	
possono	essere	modificate	da	ciascun	pannello	di	controllo.

Codificatore del pannello superiore di Duet
Il	codificatore	del	pannello	superiore	di	Duet	fornisce	il	controllo	semplice	e	immediato	delle	
impostazioni	di	livello	degli	ingressi	e	delle	uscite.	
 Livello di uscita

Per	cambiare	il	livello	di	uscita	di	Duet	(ossia,	il	livello	di	ascolto	delle	cuffie	e	
degli	altoparlanti	collegati),	premere	e	rilasciare	ripetutamente	il	codificatore	
finché	non	si	accende	il	LED	OUT	OUT.	A	questo	punto,	ruotare	il	codificatore	
sul	livello	di	ascolto	desiderato.	Il	codificatore	hardware	agisce	in	parallelo	con	
qualsiasi	controllo	di	livello	software.

 Livello di ingresso
	 Per	cambiare	il	livello	di	ingresso	di	Duet	(ossia,	il	livello	di	registrazione	di	 
	 microfoni	e	strumenti),	premere	e	rilasciare	ripetutamente	il	codificatore	finché	 
	 non	si	accende	il	LED	IN-1	o	IN-2.	A	questo	punto,	ruotare	il	codificatore	finché	 
 non si ottiene il livello di registrazione desiderato 
	 (come	visto	nel	software	di	registrazione).
 Tacitazione delle uscite

Per	tacitare	contemporaneamente	le	uscite	di	linea	e	delle	cuffie,	tenere	premuto	
il	codificatore	finché	il	LED	OUT non inizia a lampeggiare; tenere nuovamente 
premuto	per	annullare	la	tacitazione	delle	uscite.

 Controller MIDI
Il	codificatore	può	anche	inviare	dati	di	controller	MIDI	e	Posizione	brano	alle	
applicazioni	software.	Per	ulteriori	dettagli,	vedere	le	pagine	16-17.
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Funzionamento

Codifica-
tore 

hardware 
Duet  

Apogee 
Maestro

Apogee 
Control 
Panel 

(in Logic)

Riquadro 
Apogee 
Duet in 
Garage-

Band

Audio 
MIDI Setup 

Preferenze 
di sistema

Guadagno ingresso

Controllo ingressi - 
Selezione, 48v, 
Gruppo, Fase

Controllo uscite -  
Attenuazione, 
Tacitazione

Controllo uscite - 
Livello nominale

Mixer a bassa latenza

Funzioni avanzate
                 *

Controller MIDI

Tasso di 
campionamento 
(vedere pag.10)

Assegnare Duet come 
ingresso/uscita per 
OSX

*	Tutti	tranne	Gain	Mode	(modalità	guadagno)
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Maestro di Apogee
Il software Maestro di Apogee fornisce il controllo più completo di Duet, compresi il controllo 
di	tutte	le	impostazioni,	la	memorizzazione	e	il	richiamo	delle	configurazioni	e	il	missaggio	
a	bassa	latenza.	Se	il	software	di	registrazione	non	comprende	un	pannello	di	controllo	
Apogee,	utilizzare	Maestro	di	Apogee	per	eseguire	le	impostazioni.

 Mixer a bassa latenza di Maestro
 Se durante la registrazione si osserva un delay tra il momento in cui si suona o  
	 si	canta	una	nota	e	il	momento	in	cui	la	si	sente	nelle	cuffie,	può	essere	di	aiuto	 
	 il	mixer	a	bassa	latenza	di	Maestro.	Per	ulteriori	informazioni	sul	mixer	a	bassa	 
	 latenza,	vedere	le	pagine	18-21.		
 Per	una	spiegazione	completa	del	pannello	di	controllo	di	Maestro,	vedere	le	 
	 pagine	12-26.

Apogee Control Panel (Logic Pro 8, GarageBand)
Apogee	Control	Panel,	che	si	trova	nel	software	Logic	Pro	e	GarageBand	di	Apple,	fornisce	
il	controllo	delle	impostazioni	e	della	memorizzazione/richiamo	delle	configurazioni	di	Duet.	
I pannelli di controllo in questi programmi duplicano tutte le impostazioni che si trovano nel 
pannello	di	controllo	di	Maestro.

Preferenze di sistema OS X
La	finestra	System	Preferences	Sound	di	OS	X	fornisce	le	impostazioni	per	scegliere	Duet	for	
Mac	sound	input	and	output	(ingresso	e	uscita	audio	Duet	per	Mac).	Se	non	è	stato	scelto	Duet	
for	Mac	sound	I/O	nel	passo	3	della	guida	rapida,	è	possibile	farlo	in	questa	finestra.	
	 Scegliere	Menu	Mela	>	Preferenze	di	sistema;
	 Aprire	la	finestra	Sound	preference	facendo	clic	sull'icona	dell'altoparlante;
	 Fare	clic	sulla	scheda	Output	e	selezionare	Duet	nella	finestra	Device;
	 Fare	clic	sulla	scheda	Input	e	selezionare	Duet	nella	finestra	Device.

Audio MIDI Setup di OS X 
Audio	MIDI	Setup	di	OS	X	(situato	nella	cartella	Applications/Utilities)	fornisce	il	controllo	
del	tasso	di	campionamento	e	del	livello	di	uscita	di	Duet,	nonché	delle	impostazioni	per	
scegliere	Duet	for	Mac	sound	input	and	output.	Per	controllare	il	livello	di	uscita	di	Duet	ed	
eseguire la tacitazione da AMS o dalla tastiera del Mac, impostare Default Output su Duet.

Impostazione del tasso di campionamento
Duet funziona con tutti i tassi di campionamento standard, compresi tra 44,1k 
e	96k.	Nella	maggior	parte	dei	casi	il	tasso	di	campionamento	viene	impostato	
dall'applicazione	audio	con	cui	Duet	comunica.	Ad	esempio,	se	si	utilizza	Duet	
con	GarageBand,	il	tasso	di	campionamento	di	Duet	viene	automaticamente	
impostato	a	44,1k,	per	coincidere	con	quello	del	brano	di	GarageBand.	
Per	le	applicazioni	audio	che	non	includono	un'impostazione	del	tasso	di	
campionamento, quale iTunes, il tasso di campionamento di Duet può essere 
impostato	in	Audio	Midi	Setup.
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Maestro di Apogee

Preferenze di sistema OS X

Apogee Control Panel

Audio MIDI Setup di OS X 
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Controllo Maestro - Livelli

Menu interfaccia
Quando Duet viene correttamente rilevato da Maestro, Duet più il numero seriale 
dell'unità	appaiono	in	questo	menu	a	tendina.

Identify Unit
Facendo	clic	su	questo	pulsante	si	verifica	che	sia	stabilita	la	comunicazione	tra	il	
software	Maestro	e	l'hardware	Duet,	illuminando	tutti	i	LED	del	pannello	superiore.	
Fare clic nuovamente sul pulsante per riportare i LED di Duet alla funzione 
normale.
 
Input 
Questo menu viene utilizzato per selezionare il connettore di ingresso e il livello:

XLR Line +4dBu – Impostare Input su XLR Line +4dBu se è stato 
collegato un ingresso di linea di livello professionale, quale un console di 
missaggio professionale, ai connettori  IN	(XLR).
XLR Line –10 dBV – Impostare Input su XLR Line -10dBV se è stato 
collegato un ingresso di linea di livello consumer, quale un lettore CD, ai 
connettori  IN	(XLR).
XLR Mic – Impostare Input su XLR Mic se è stato collegato un microfono 
ai connettori  IN (XLR).	Il	guadagno	è	regolabile	tra	10	e	75	dB.
Instrument – Impostare Input su Instrument se è stata collegata una 
chitarra o una tastiera ai connettori  IN (1/4”);	il	guadagno	è	
regolabile	tra	0	e	65	dB.	A	questi	ingressi	è	inoltre	possibile	collegare	
lettori	CD	e	altri	dispositivi	di	livello	consumer	(-10	dBV).

Quando Input è impostato su XLR Mic o Instrument, sono accessibili i controlli 
seguenti:

Group – Selezionare l'una o l'altra di queste caselle per raggruppare 
l'impostazione del guadagno di entrambi gli ingressi, in modo tale 
che	il	codificatore	hardware	o	un	codificatore	software	controlli	
contemporaneamente	entrambi	i	guadagni	di	ingresso.	Se	è	presente	un	
compenso di guadagno tra gli ingressi quando è selezionato Group, tale 
compenso	viene	mantenuto.	
Codificatore software del livello in ingresso – Il guadagno di ciascun 
ingresso	può	essere	controllato	da	questo	codificatori	software.	Il	livello	di	
guadagno	è	indicato	nella	casella	del	valore	a	destra	del	codificatore.
Icona di fase – Selezionare questa casella per invertire la polarità del 
segnale	in	ingresso.	In	determinate	circostanze	quando	si	utilizzano	due	
microfoni su un'unica sorgente, l'inversione della polarità di un microfono 
potrebbe	determinare	un	suono	fuller.	Ad	esempio,	quando	si	collocano	i	
microfoni sopra e sotto uno snare drum, il suono fuller si ottiene quando 
viene	invertita	la	polarità	del	microfono	inferiore.
48V – Selezionare questa casella per attivare l'alimentazione phantom a 
48	volt	sulle	connessioni	XLR.	Per	funzionare,	i	microfoni	a	condensatore	
richiedono	l'alimentazione	phantom.	

Maestro

1

2

3

4

5

6
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Level 
Il livello nominale o medio delle uscite di linea vengono impostate con questo menu:

Line out – Impostare Level su Line out se si collega il connettore OUT-L  
o OUT-R	di	Duet	ad	altoparlanti	alimentati,	un	sistema	hi-fi	o	una	console	
di	missaggio.
Instrument Amp – Impostare Level su Instrument Amp se si collega 
il connettore OUT-L  o OUT-R	di	Duet	a	un	ingresso	di	amplificazione	
strumento.	Il	livello	di	uscita	è	fisso.

Codificatore software del livello in uscita
Il	livello	di	entrambe	le	uscite	di	linea	e	cuffie	è	controllato	simultaneamente	con	
questo	codificatore	software,	quando	Level è impostato su Line out.	Il	livello	di	
attenuazione	è	indicato	nella	casella	del	valore	a	destra	del	codificatore.
 
Mute 
Selezionando questa casella si tacitano contemporaneamente le uscite di  
linea	e	cuffie.

7

8

9

1

2

3
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Maestro

4

5
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Controllo Maestro – Avanzate

OUT Muting – Queste caselle di controllo determinano quali uscite vengono 
effettivamente tacitate quando viene attivata la funzione Mute.	Di	seguito	sono	
riportate alcune impostazioni di esempio:

Se le caselle sono selezionate come indicato a sinistra, 
è possibile commutare tra una modalità di registrazione 
(cuffie	attivate,	altoparlanti	collegati	alle	uscite	di	
linea	disattivati)	e	una	modalità	di	riproduzione	(cuffie	
disattivate,	altoparlanti	attivati)	con	un'unica	azione	–	
attivando e disattivando Mute.		Poiché	il	controllo	del	
volume delle due uscite è condiviso, è una buona idea 
verificare	il	livello	prima	di	annullare	la	tacitazione	delle	
uscite	di	linea.

Quando le caselle sono selezionate come mostrato a 
sinistra,	le	uscite	cuffie	non	vengono	mai	tacitate;	quando	
Mute	è	attivato,	vengono	tacitate	solo	le	uscite	di	linea.	

Mic/Instrument gain mode – Questo menu imposta la modalità di guadagno in 
ingresso:

Max. Gain range – È disponibile l'intervallo di guadagno completo, con 
un	interruttore	relé	che	scatta	dopo	i	primi	10	dB	di	guadagno.	
Clickless Operation – L'intervallo di guadagno viene ridotto 
leggermente,	ma	non	viene	impiegato	alcun	relé,	determinando	un	
funzionamento	senza	clic	dell'impostazione	del	guadagno.	Un	intervallo	
di guadagno appropriato viene impostato in base alle impostazioni Input 
e 48V.

Meters Display
Questo menu seleziona il segnale da visualizzare sui misuratori del pannello 
superiore; le opzioni sono Input, Output o Follow Selection.	Se	si	sceglie	Follow 
Selection, il display del misuratore segue l'indicatore d'impostazione del pannello 
superiore; così, se è selezionato IN-1 o IN-2, il misuratore visualizza entrambi gli 
ingressi, quando è selezionato OUT,	il	misuratore	visualizza	l'uscita	stereo.	
 
Over Hold
Quando Over Hold è impostato su Infinite, le indicazioni Over rimangono “attive” 
finché	non	vengono	cancellate	dall'utente.	Gli	Over	possono	essere	cancellati	
facendo clic sull'indicatore Over o su Clear Overs	nel	riquadro	Maestro	Mixer.	
Se Over Hold è impostato a 2 secondi, le indicazioni Over si cancellano 
automaticamente	dopo	due	secondi.

Maestro

2

3

4

1
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Controllo Maestro – Avanzate: Controller MIDI

Number of MIDI Controllers	–	Per	accedere	alla	funzionalità	MIDI	di	Duet,	creare	
da	1	a	4	istanze	di	controller	MIDI	virtuali	mediante	questo	contatore.	Una	volta	
creata	l'istanza	di	1	o	più	controller	MIDI,	questi	possono	essere	modificati	con	il	
codificatore	del	pannello	superiore	o	con	il	codificatore	software	corrispondente.	
Per	selezionare	un	controller	MIDI	mediante	il	codificatore	del	pannello	superiore,	
premere	il	codificatore	finché	il	menu	a	tendina	di	Duet	non	visualizza	la	selezione	
del	controller	MIDI	desiderato	(vedere	pag.	16	per	ulteriori	informazioni	sui	menu	
a	tendina	di	Duet).	Si	osservi	che	quando	sono	selezionati	i	controller	MIDI	non	è	
acceso alcun LED del pannello superiore (IN-1, IN-2, OUT).

Quando Number of MIDI Controllers è impostato su 1 - 4, sono accessibili le 
impostazioni seguenti:

MIDI encoder	–	Questo	codificatore	software	è	utilizzato	per	inviare	dati	
MIDI	Controller	o	Song	Position	alle	applicazioni	software

Quando il menu della funzione è impostato su Controller, sono accessibili le 
impostazioni seguenti:

Number	–	Questa	casella	visualizza	il	numero	CC	MIDI.		È	possibile	
inserire	la	gamma	completa	di	controlli	a	7	bit	(0	-	127).
Chan – Questa casella visualizza il canale MIDI sul quale sono inviati i 
dati	del	controller.	È	possibile	inserire	numeri	compresi	tra	1	e	16.
Value	–	È	possibile	inserire	direttamente	numeri	compresi	tra	0	-	127		
(seguiti dai tasti Enter o Return	per	accettare	il	valore),	sebbene	la		
rotazione	del	codificatore	prevaricherà	l'immissione	numerica.

Quando il menu della funzione è impostato su Song Position, è accessibile 
l'impostazione seguente:

1/4 Note – Questa casella visualizza la posizione attuale di Song 
Position,	definita	come	numero	di	battute	di	nota	da	1/4	dall'inizio	del	
brano	(battuta	0).

Maestro
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Maestro

Missaggio a bassa latenza

Prima	di	descrivere	le	funzioni	del	riquadro	Mixer	di	Maestro,	è	opportuno	riportare	alcune	
informazioni generali relative alla latenza e alle impostazioni di registrazione basata su 
computer,	che	possono	aiutare	a	comprendere	meglio	tali	funzioni.

Durante la registrazione con la maggior parte delle applicazioni audio digitali basate su 
computer, il delay tra l'ingresso e l'uscita del sistema di registrazione, spesso disturba la 
temporizzazione	dell'esecuzione	dei	musicisti.	Questo	delay,	noto	come	latenza,	determina	
che	il	musicista	sente	le	note	che	produce	alcuni	millisecondi	dopo	averle	prodotto.	
Come sa bene chiunque abbia sperimentato l'effetto eco durante una telefonata, delay 
relativamente brevi possono generare confusione nei tempi di qualsiasi conversazione, nel 
parlato	o	nella	musica.

Per	illustrare	l'effetto	della	latenza,	nella	figura	A	è	illustrato	un	tipico	percorso	di	segnale	
di	una	sessione	di	overdub	vocale.	Il	vocalist	canta	nel	microfono,	instradato	verso	
un convertitore da analogico a digitale, quindi all'applicazione software audio per la 
registrazione.	Nell'applicazione	software,	il	segnale	dal	vivo	del	vocalist	viene	missato	
con l'esecuzione di tracce registrate in precedenza, instradato verso un convertitore da 
digitale	ad	analogico,	e	infine	alle	cuffie	del	vocalist.	Un	leggero	delay	si	accumula	in	ogni	
fase	della	conversione,	mentre	una	quantità	maggiore	si	verifica	attraverso	l'applicazione	
software,	con	il	risultato	che	il	vocalist	sente	la	propria	esibizione	nelle	cuffie	con	un	delay	
di diversi	millisecondi.	

Figura 1

Interfaccia  
hardware

Traccia abilitata alla 
registrazione

Uscita	da	DAW	

Latenza   

Latenza   Latenza   

Latenza    

Applicazioni  
audio
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Missaggio a bassa latenza - segue

Instradando l'ingresso hardware direttamente all'uscita hardware ed eseguendo il 
missaggio	in	riproduzione	come	indicato	nella	Figura	B,	è	possibile	fornire	al	vocalist	un	
segnale	di	monitoraggio	nelle	cuffie	con	un	delay	molto	più	breve.	

Anzitutto,	il	segnale	in	registrazione	(in	questo	caso	un	microfono	vocale)	viene	diviso	
subito dopo la fase A/D e instradato sia all'applicazione software per la registrazione sia 
direttamente alle uscite hardware senza passare attraverso al software responsabile della 
latenza;	in	questo	modo	si	crea	un	percorso	a	bassa	latenza	dal	microfono	alle	cuffie.	
Successivamente, un mix stereo delle tracce di riproduzione viene instradato al mixer a 
bassa	latenza	e	combinato	con	gli	ingressi	hardware.	Ciò	consente	all'esecutore	di	sentire	
se stesso senza un delay confuso durante l'ascolto delle tracce di esecuzione per la 
registrazione	degli	overdub.

Si osservi che il mixer dell'applicazione software viene utilizzato per impostare un mix 
di tracce di esecuzione stereo, mentre il mixer a bassa latenza viene utilizzato per il 
bilanciamento	tra	il	mix	di	riproduzione	stereo	e	gli	ingressi	hardware.

Maestro

Figura 2

Figura B
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Maestro Mixer

Maestro Mixer fornisce la possibilità di fondere gli ingressi hardware di Duet con la 
riproduzione di un'applicazione audio e instradare il mix risultante alle uscite hardware di 
Duet.	Usando	il	mixer	di	Maestro,	è	possibile	creare	un	mix	di	monitoraggio	in	cui	la	latenza	
non	sia	un	problema.

Input 1, Input 2 – Questi canali 
forniscono servizi di missaggio per 
instradare e missare il segnale 
proveniente da ciascun ingresso 
hardware di Duet direttamente sulle 
uscite	hardware	di	Duet.	La	sorgente	
di ingresso effettiva è determinata 
dall'impostazione	Input	(pag.	12).

From Mac  - Questo canale fornisce 
servizi di missaggio per missare 
l'uscita di un'applicazione audio sulle 
uscite	hardware	di	Duet.		

To Hardware – Questo canale 
fornisce il livello dell'uscita del mixer 
e	l'instradamento.	
 
Quando To Hardware è impostato 
su Out L-R, l'uscita del mixer viene 
inviata	alle	uscite	hardware	di	Duet.

Quando To Hardware è impostato 
su None, il mixer è disattivato e 
l'uscita dell'applicazione audio viene 
inviata direttamente alle uscite 
hardware di Duet, bypassando così 
Maestro	Mixer.	

Maestro
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Lavorare con Maestro Mixer

È necessario Maestro Mixer?
Il mixer di Maestro serve a fornire un mix di monitoraggio a bassa latenza durante la 
registrazione.	Perciò	se	si	utilizza	Duet	per	ascoltare	l'audio	di	iTunes	o	quello	di	un	altro	
programma,	non	è	necessario	utilizzare	il	mixer.	Impostare	To Hardware su None per 
disabilitare	il	mixer.

È	possibile	che	la	latenza	dello	specifico	sistema	di	registrazione	sia	sufficientemente	
bassa	da	risultare	impercettibile.	La	latenza	del	sistema	è	determinata	dall'impostazione	
del buffer del software di registrazione, e se il proprio Mac è abbastanza potente, è 
possibile	impostare	il	buffer	a	un	valore	più	basso	(latenza	più	breve)	senza	sperimentare	
clic	e	scoppiettii	nell'uscita	audio.	Se	la	latenza	non	rappresenta	un	problema	durante	la	
registrazione, il mixer può essere disabilitato impostando To Hardware su None.

Impostazioni software di registrazione
Prima	di	utilizzare	il	mixer	di	Maestro,	è	necessario	variare	alcune	impostazioni	nel	
software	di	registrazione.	
Software monitoring	-	Poiché	il	segnale	da	registrare	viene	monitorato	attraverso	il	mixer	
di Maestro, le uscite delle tracce software registrate attivamente dovrebbero essere tacitate 
-	dopotutto,	si	tratta	della	sorgente	della	latenza.	La	maggior	parte	delle	applicazioni	
software fornisce un'opzione per disattivare il monitoraggio software delle tracce in 
registrazione.	In	Logic	Pro,	ad	esempio,	l'opzione	di	monitoraggio	software	si	trova	nella	
stessa	finestra	Audio	preferences	utilizzata	per	selezionare	Duet	come	periferica	hardware	
(Logic	Pro	>	Preferences	>	Audio).	Deselezionare	la	casella	Software	Monitoring.
Playback mix - Nel software di registrazione, impostare un mix di tutte le tracce di 
esecuzione	e	instradarlo	su	Out	L-R.	Se	l'uscita	globale	del	mix	è	controllata	da	un	fader	
principale,	si	consiglia	di	impostare	quest'ultimo	a	0	dB.	

Impostazioni di Maestro
Maestro Mixer settings - Impostare inizialmente l'ingresso dei fader, From Mac e To 
Hardware	a	0	dB.	Impostare	il	menu	To Hardware	su	Out	L-R.	
Dopo aver eseguito la selezione dell'ingresso e impostato il guadagno (come descritto 
a	pagina	12),	il	segnale	dovrebbe	essere	visualizzato	su	entrambi	i	misuratori	Input	e	
To	Hardware.	Se	il	LED	Over	di	Input	si	accende,	ridurre	il	guadagno	dell'ingresso	nella	
finestra	Maestro	Control.	Se	il	LED	Over	di	To	Hardware	si	accende,	ridurre	il	fader	Input.	
Iniziare	ora	l'esecuzione	dalla	sessione.	Il	segnale	di	esecuzione	dovrebbe	essere	
visualizzato	sui	misuratori	From	Mac	e	To	Hardware.	Utilizzare	i	fader	From	Mac	e	Input	
per	istituire	il	bilanciamento	tra	i	segnali	di	ingresso	e	riproduzione.	Se	si	trova	un	buon	
bilanciamento	ma	il	LED	Over	di	Hardware	si	accende,	ridurre	il	fader	To	Hardware.	
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Maestro

Preferenze di Maestro – Preferenze di Duet

Le	due	preferenze	di	Maestro	specifiche	per	Duet	sono	descritte	di	seguito.	Per	una	
descrizione	di	altre	impostazioni	di	preferenza,	vedere	a	pag.	24.

Launch Maestro automatically when connecting a device (Avvia Maestro 
automaticamente quando viene collegata una periferica) 
Selezionando questa casella, Maestro viene avviato automaticamente quando Duet viene 
rilevato	sul	bus	FireWire	del	Mac.	Affinché	vengano	richiamate	le	impostazioni	del	mixer	di	
Maestro	dopo	il	riavvio	del	computer,	questa	casella	deve	essere	selezionata.	Se	questa	
preferenza è deselezionata, le impostazioni Maestro Mixer non saranno conservate dopo 
che	il	Mac	è	stato	spento	o	riavviato.

Enable Duet pop-ups (Attiva menu a tendina di Duet)
Quando	questa	casella	è	selezionata,	appaiono	elementi	a	comparsa	del	decodificatore	sul	
Mac, che visualizzano varie impostazioni di Duet, tra cui i livelli di ingresso e uscita, Input, 
Group	e	tacitazione.	A	titolo	illustrativo,	sono	riportati	alcuni	esempi	di	seguito:

IN-1 selezionato,  
Input impostato su  XLR Mic,  
codificatore	impostato	a	40	dB

IN-1 e IN-2 selezionati,  
Group selezionato,  
Input 1 impostato su XLR Mic,  
Input 2 impostato su Instrument,  
codificatore	1	impostato	a	30	dB,	 
codificatore	2	impostato	a	40	dB.
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Maestro

OUT	Level	impostato	su	–12	dB	
Mute attivato 
OUT muting impostata come segue

Mute attivato,  
OUT muting impostata come segue

Codificatore	impostato	su	modifica	MIDI	Controller	1
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Maestro

Controlli rotativi
Mouse motion	–	Questa	selezione	definisce	il	movimento	del	mouse	necessario	a	
regolare	i	controlli	rotativi.
Fine adjust key	–	Questa	selezione	definisce	il	comando	chiave	per	apportare	
regolazioni	fini	a	qualsiasi	controllo	rotativo.	

Controlli fader
Fine adjust key -	Questa	selezione	definisce	il	
comando	chiave	per	apportare	regolazioni	fini	a	
qualsiasi	controllo	fader.
0dB key	–	Questa	selezione	definisce	il	comando	
chiave	per	impostare	il	fader	a	0	dB	quando	si	fa	clic	
nella	finestra	di	valore	del	livello.
Ungroup faders -	Questa	selezione	definisce	il	
comando chiave per regolare un lato dei fader stereo 
From	Mac	e	To	Hardware.

Controlli pan
Fine adjust key	-	Questa	selezione	definisce	il	
comando	chiave	per	apportare	regolazioni	fini	a	
qualsiasi	controllo	pan.
Center	-	Questa	selezione	definisce	il	comando	chiave	
per	impostare	il	controllo	pan	a	<0>	o	centro,	quando	si	
fa	clic	nella	finestra	del	valore	pan.

Altro
Mute/Solo all	-	Questa	selezione	definisce	il	comando	chiave	per	attivare	tutte	le	
tacitazioni	(Mute)	o	gli	assolo	(Solo)	quando	si	fa	clic	sui	pulsanti	Mute	o	Solo.

Preferenze aggiuntive
Launch Maestro automatically when connecting a device - Selezionando questa 
casella,	Maestro	viene	avviato	automaticamente	quando	Duet	viene	rilevato.

Maestro > About Maestro
Selezionando questo menu si 
apre	la	finestra	illustrata	a	destra,	
che riporta le varie versioni 
software	e	firmware.	

Menu per menu

Maestro > Preferences
Selezionando	questo	menu	si	apre	la	finestra	Preferences,	nella	quale	è	possibile	definire	le	
azioni	di	controllo	del	mixer.
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Maestro

Menu per menu

Maestro > Hide Maestro
Scegliendo	questa	voce	di	menu	si	nasconde	l'applicazione	Maestro.

Maestro > Hide Others 
Scegliendo	questa	voce	di	menu	si	nascondono	tutte	le	altre	applicazioni	aperte.

Maestro > Show All
Se in precedenza è stata selezionata l'opzione Hide Others, scegliendo questa voce di 
menu	si	rivelano	tutte	le	applicazioni	aperte	in	Finder.

Maestro > Quit Maestro 
Scegliendo	questa	voce	di	menu	si	chiude	il	programma	Maestro.

File:
File > Open
Scegliere	questa	voce	di	menu	per	cercare	un	file	di	configurazione	di	Maestro	salvato	in	
precedenza	e	aprirlo.

File > Open Recent 
Scegliere	questa	voce	di	menu	per	riaprire	un	file	di	configurazione	di	Maestro	aperto	
recentemente.

File > Close Window 
Scegliere	questa	voce	di	menu	per	chiudere	la	finestra	“attiva”	o	in	primo	piano.

File > Save 
Scegliere	questa	voce	di	menu	per	salvare	le	impostazioni	correnti	di	tutte	le	finestre.

File > Save As
Scegliere	questa	voce	di	menu	per	salvare	le	impostazioni	correnti	di	tutte	le	finestre	
come	file	con	nome.
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Maestro

Window:
Window > Minimize
Scegliere	questa	voce	di	menu	per	ridurre	a	icona	la	finestra	in	primo	piano	sul	dock	del	
sistema	operativo.

Window > Zoom
Scegliere	questa	voce	di	menu	per	ingrandire	la	finestra	attiva	di	Maestro.

Window > Bring All to Front
Scegliere	questa	voce	di	menu	per	portare	in	primo	piano	tutte	le	finestre	di	Maestro	
rispetto	a	quelle	di	altre	applicazioni.

Tools:
Tools > Maestro Control
Scegliere	questa	voce	di	menu	per	aprire	la	finestra	Maestro	Control.

Tools > Maestro Mixer
Scegliere	questa	voce	di	menu	per	aprire	la	finestra	Routing/Mixer.

Tools > Reset Symphony Clocking
In	alcuni	casi	non	è	possibile	rilevare	le	interfacce	di	Apogee	finché	non	viene	
reimpostata	l'impostazione	di	clock	della	prima	interfaccia.	Scegliere	Reset	Symphony	
Clocking	per	reimpostare	la	sorgente	di	clock	sulla	prima	interfaccia	a	Internal	o	External.

Tools > Refresh Connections
Scegliere questa voce di menu per rieseguire la scansione dei collegamenti al computer 
dell'hardware	Apogee.

Tools > Reset Mixer
I mixer di Maestro possono essere reimpostati con questa voce di menu; scegliere Reset 
Displayed	per	reimpostare	il	mixer	visualizzato	nella	finestra	Maestro	Mixer;	scegliere	
Reset	All	per	reimpostare	tutti	i	mixer.

Tools > Reset Routing
Scegliere questa voce di menu per reimpostare i riquadri Input e Output alla 
configurazione	“pass	through”,	dove	gli	ingressi	e	uscite	hardware	e	software	sono	
collegati	con	criterio	uno	a	uno.

Menu per menu



Duet – Manuale dell'utente

27Collegamento di Duet  

Collegare i monitor alle uscite da 1/4” 

con le icone  etichettate OUT-L e 

OUT-R sul	cavo	breakout.

Collegare	le	cuffie	all'uscita	

da 1/4” con l'icona  .

Collegamento di Duet 

Monitor e cuffie

Se gli ingressi dei monitor 

o gli ingressi stereo sono 

di tipo RCA, utilizzare gli 

adattatori in dotazione per 

eseguire	il	collegamento.	

Inserire l'adattatore nelle 

connessioni OUT-L 

e OUT-R sul cavo 

breakout di Duet, quindi 

collegare	 il	 cavo	 RCA.



Duet – Manuale dell'utente

28 Collegamento di Duet  

Collegamento di Duet 

Strumento e microfono

Collegare uno strumento 

all'ingresso da 1/4” 

con l'icona   etichettata 

IN-1 sul	cavo	breakout.

Collegare un microfono all'ingresso 

XLR con l'icona     etichettata IN-2 

sul cavo breakout.
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Collegamento di Duet

Strumento e strumento

Collegare uno strumento 

all'ingresso da 1/4” 

con l'icona      etichettata 

IN-1sul	cavo	breakout.

Collegare uno strumento 

all'ingresso da 1/4” 

con l'icona    etichettata 

IN-2 sul	cavo	breakout.
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Collegamento di Duet

Microfono e microfono

Collegare un microfono all'ingresso 

XLR con l'icona    etichettata IN-2 

sul	cavo	breakout.

Collegare un microfono all'ingresso 

XLR con l'icona     etichettata IN-1 

sul	cavo	breakout.
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Collegamento di Duet

Collegare i monitor alle uscite da 1/4” 
con le icone  etichettate OUT-L e 
OUT-R sul	cavo	breakout.

Monitor alimentati

Duet è anche il metodo migliore per ascoltare l'audio del Mac, sia che si tratti della 
riproduzione	della	libreria	iTunes,	di	una	radio	Internet	o	di	CD/DVD.

Per	collegare	le	uscite	di	linea	Duet	direttamente	ad	altoparlanti	alimentati,	occorrono	2	
cavi con spine tip-sleeve da 1/4" su un'estremità per il collegamento alle prese OUT-L  
e OUT-R di Duet e il connettore appropriato sull'altra estremità per il collegamento agli 
altoparlanti.	Per	comodità,	sono	forniti	in	dotazione	con	Duet	2	adattatori	1/4"	-	RCA,	che	
consentono l'utilizzo di cavi RCA - RCA comunemente disponibili per il collegamento alle 
apparecchiature	stereo	domestiche.

Durante	il	collegamento	ad	altoparlanti	alimentati,	utilizzare	la	manopola	codificatore	di	Duet	
per	controllare	il	volume	di	riproduzione.
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Collegamento a un impianto stereo domestico

Per	 collegare	 Duet	 direttamente	 all'impianto	 stereo	 domestico,	 inserire	 gli	 adattatori	 
1/4” - RCA nelle prese OUT-L e OUT-R di Duet e utilizzare un normale cavo RCA - RCA per 
il	collegamento	all'ingresso	AUX	o	CD	del	ricevitore.	

Durante	il	collegamento	a	un	impianto	stereo	domestico,	impostare	l'uscita	di	Duet	a	0	dB	
(ossia,	volume	pieno)	e	utilizzare	il	controllo	del	volume	del	ricevitore	per	impostare	il	livello	
di	riproduzione.

Una	 volta	 eseguiti	 i	 collegamenti	 audio,	 collegare	 la	 porta	 Firewire	 di	 Duet	 al	 Mac.	 
A	connessione	avvenuta,	apparirà	la	finestra	di	dialogo	illustrata	di	seguito.		Fare	clic	su Yes 
per	scegliere	Duet	per	l'uscita	e	l'ingresso	audio	del	Mac.

Questa	selezione	può	essere	inoltre	eseguita	nel	pannello	System	Preferences	>	Sound	>	
Output.

In	iTunes,	selezionare	Computer	come	uscita	audio.	L'audio	riprodotto	in	iTunes	verrà	ora	
instradato	verso	Duet	e	l'uscita	sarà	disponibile	sul	proprio	impianto	stereo	domestico.
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Risoluzione dei problemi

D: quando	si	preme	il	codificatore	per	selezionare	un	ingresso	o	un'uscita,	la	selezione	non	
è	disponibile.	Perché?	

R: quando gli ingressi sono impostati su XLR line o l'uscita è impostata su 
Instrument Amp,	il	codificatore	è	disattivato,	perciò	non	è	selezionabile

D: quando	si	preme	il	codificatore	per	selezionare	un	ingresso	o	un'uscita,	TUTTI i LED si 
spengono.	Perché?	

R: quando viene creata un'istanza di 1 o più controller MIDI e questi vengono 
selezionati	per	il	controllo	mediante	il	codificatore	del	pannello	superiore,	tutti	i	
LED degli ingressi e uscite del pannello superiore si spengono per indicare la 
selezione	di	un	controller	MIDI.	Se	sono	attivati	i	menu	a	tendina	nelle	preferenze	
di	Maestro,	il	controller	MIDI	selezionato	sarà	visualizzato	sullo	schermo.

D: è	stata	collegata	la	chitarra,	ma	non	si	ottiene	alcun	ingresso.	Che	cosa	occorre	
controllare?

R: In Maestro, accertarsi di impostare Input su Instrument.

D: non	si	ottiene	alcuna	uscita	dalle	applicazioni	audio.	Che	cosa	occorre	controllare?
R: se il LED OUT	lampeggia,	l'uscita	è	tacitata.	Premere	e	tenere	premuto	il	
codificatore	del	pannello	superiore	finché	il	LED	OUT	smette	di	lampeggiare.	
Inoltre, se l'uscita di Maestro Mixer è impostata su Out L-R, occorre sollevare il 
fader	From	Mac	per	inviare	le	uscite	dell'applicazione	audio	alle	uscite	di	Duet.

D: si	desidera	che	Maestro	si	avvii	automaticamente	ogni	volta	che	si	connette	Duet.	 
Che	cosa	occorre	impostare?

A: aprire	Maestro	>	Preferences	e	selezionare	la	casella	di	controllo	Launch 
Maestro automatically when connecting a device.

D: è	possibile	impostare	le	uscite	linea	e	cuffie	su	livelli	diversi?
R: le	uscite	linea	e	cuffie	sono	sempre	controllate	simultaneamente.	Per	
impostare	il	bilanciamento	tra	le	cuffie	e	gli	altoparlanti	connessi	alle	uscite	di	
linea,	impostare	opportunamente	l'amplificatore	degli	altoparlanti.	È	possibile	
tacitare	le	uscite	linea	e	cuffie	in	modo	indipendente.

D: in	che	modo	è	possibile	reimpostare	Duet?
R: per	reimpostare	Duet	premere	e	tenere	premuto	il	codificatore	per	5	secondi.	
Tutte	le	impostazioni	torneranno	allo	stato	predefinito.
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Uso di Duet con Apple Soundtrack Pro

Scegliere	Soundtrack	Pro	>		Preferences.

Fare	clic	sulla	scheda	Recording.
Selezionare Duet	in	entrambi	i	menu	Input	e	Monitor.
Chiudere	la	finestra	Preferences	dopo	aver	eseguito	
le	impostazioni.

Uso di Duet con Apple MainStage

Scegliere	MainStage	>	Preferences

 

Fare clic sulla scheda Audio/Midi
Selezionare Duet nei menu Audio Output e Audio 
Input
Impostare	I/O	Buffer	Size	a	128
Chiudere	la	finestra	Preferences	dopo	aver	eseguito	
le	impostazioni.

Per	controllare	Duet	direttamente	dalla	sessione	
di	Mainstage,	scegliere	Mainstage	>	Open	Apogee	
Control	Panel.

Guida alle applicazioni Core Audio
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Uso di Duet con Apple Final Cut Pro

Scegliere	Final	Cut	Pro	>	Audio/Video	Settings.

Fare	clic	sulla	scheda	A/V	Devices.
Selezionare Duet	nel	menu	Audio.
Fare clic su OK.

 

Uso di Duet con Ableton Live

Scegliere	Live	>		Preferences

Fare	clic	sulla	scheda	Audio.
Selezionare CoreAudio	nel	menu	Driver	Type.
Selezionare Duet in entrambi i menu Audio Input 
Device	e	Audio	Output	Device.
Impostare	Buffer	Size	a	128.
Chiudere	la	finestra	Preferences	dopo	aver	eseguito	
le	impostazioni.

Guida alle applicazioni Core Audio
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Uso di Duet con MOTU Digital Performer

Scegliere	Setup	>	Configure	Audio	System	>	
Configure	Hardware	Driver

Nella	finestra	Configure	Hardware	Driver,	selezionare	
CoreAudio	nel	menu	superiore.
Selezionare Duet	nell'elenco	delle	periferiche.
Impostare	Buffer	Size	a	128.
Impostare	Host	Buffer	Multiplier	a	1.
Impostare	Work	Priority	su	Low.
Fare clic su OK.

  

Uso di Duet con Steinberg Nuendo

Scegliere	Devices	>	Device	Setup

Nella	finestra	Devices,	fare	clic	su	VST	Audio	
System.
Selezionare	Duet	nel	menu	ASIO.

Una	volta	che	Duet	è	stata	riconosciuta	da	Nuendo,	
selezionare	Duet	nella	finestra	Devices.
Fare	clic	su	Control	Panel.
Nel	menu	a	tendina	ASIO	Settings,	impostare	Buffer	
Size	a	128	e	fare	clic	su	OK.
Nella	finestra	Device	Setup,	fare	clic	su	OK.

Guida alle applicazioni Core Audio
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Caratteristiche e specifiche tecniche

Due	canali	di	ingresso	e	uscita	audio	a	24	bit/96kHz	di	qualità	professionale•	
Due	ingressi	XLR	bilanciati,	con	alimentazione	phantom	da	48V	selezionabile•	
Ingresso	max	-	+4	dBu	impostazione:	20	dBu;	-10	dBV	impostazione:	+8	dBV•	
Guadagno	preamplificazione	microfonica:	10	~	75	dB•	
Due ingressi strumento ad alta impedenza sbilanciati•	
Un'uscita	cuffie	stereo	ad	alto	livello•	
Due	uscite	di	linea	a	-10	dBV	sbilanciate	per	altoparlanti	alimentati•	
Manopola controller multifunzione per il controllo del guadagno in ingresso e controllo MIDI •	
assegnabile
Misuratori LED multi-segmento per la visualizzazione dei livelli in ingresso e uscita•	
FireWire 400, compatibile con Mac OS X Core Audio•	
Integrazione	e	controllo	con	GarageBand	di	Apple,	Logic	Pro,	Logic	Express	 •	
e	Final	Cut	Studio	(Soundtrack	Pro)
Compatibile con qualsiasi applicazione audio conforme a Core Audio•	
Software Maestro di Apogee per il controllo avanzato e il missaggio a bassa latenza•	

 
Requisiti di sistema

Computer:	Mac	G4	1GHz	o	superiore,	CPU	PPC	o	Intel  
Memoria:	1	GB	di	RAM	minimo,		2	GB	consigliati
OS	X:	10.4.11	o	successivo	installato,	10.5.3	o	successivo	caldamente	consigliato.
Collegamento: porta FireWire 400
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Notifiche

Registrazione del possessore

Il	numero	seriale	si	trova	sul	pannello	posteriore	dell'unità.	Si	consiglia	di	annotare	il	numero	seriale	nello	spazio	
riportato	qui	di	seguito.	Farvi	riferimento	ogni	volta	che	ci	si	rivolge	a	un	centro	autorizzato	Apogee	Electronics	
per	assistenza	o	riparazioni.	Accertarsi	di	restituire	immediatamente	la	scheda	di	garanzia	debitamente	
compilata.

N.	seriale	Duet________________________________________________________________________

Data	di	acquisto______________________________________________________________________
 
Rivenditore__________________________________________________________________________

Telefono____________________________________________________________________________

Indirizzo_____________________________________________________________________________

ATTENZIONE:
qualsiasi	manomissione	o	modifica	non	autorizzata	esplicitamente	da	APOGEE	ELECTRONICS	
CORPORATION	può	invalidare	l'autorizzazione	all'uso	di	questa	apparecchiatura	ai	sensi	delle	normative	FCC.

Si prega di registrare la presente unità compilando la scheda di registrazione allegata o 
accedendo alla registrazione in linea all'indirizzo:

http://www.apogeedigital.com/register/ 

Avvertenze

Avvertenza FCC
Questa apparecchiatura è stata collaudata e trovata conforme ai limiti di una periferica digitale di Classe 
B,	ai	sensi	della	parte	15	delle	normative	FCC.	Questi	limiti	sono	progettati	per	fornire	una	protezione	
ragionevole	contro	interferenze	dannose	durante	il	funzionamento	in	un	ambiente	commerciale.	
Questa apparecchiatura genera, utilizza e può irradiare energia a frequenza radio e, se non installata 
e utilizzata secondo il manuale di istruzioni, potrebbe causare interferenze dannose alle comunicazioni 
radio.	L'utilizzo	di	questa	apparecchiatura	in	un'area	residenziale	può	causare	interferenze	dannose,	
nel qual caso l'utente sarà tenuto ad adottare le misure necessarie a proprie spese per correggere le 
interferenze.

Avviso relativo al Copyright

Duet di Apogee è una periferica basata su computer e come tale contiene e utilizza software 
memorizzato	nelle	ROM.	Questo	software	e	tutta	la	documentazione	correlata,	compreso	questo	
Manuale	dell'utente	contengono	informazioni	proprietarie	protette	dalle	leggi	sul	copyright.	Tutti	i	diritti	
sono	riservati.	Nessuna	parte	del	presente	software	e	della	documentazione	correlata	può	essere	
copiata,	trasferita	o	modificata.	È	vietato	modificare,	adattare,	tradurre,	noleggiare,	distribuire,	rivendere	
per	profitto	o	creare	lavori	derivati	basati	sul	software	e	sulla	documentazione	correlata	o	qualsiasi	parte	
degli	stessi	senza	previo	consenso	scritto	di	Apogee	Electronics	Corporation,	U.S.A.
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Informazioni sulla registrazione e la garanzia

Si prega di registrare Duet, compilando la Scheda di registrazione acclusa o il modulo di registrazione in 
linea	sul	sito	web:	http://www.apogeedigital.com/support/.	In	questo	caso,	Apogee	può	contattare	l'utente	
per	fornire	informazioni	aggiornate.	Con	lo	sviluppo	di	miglioramenti	e	aggiornamenti,	l'utente	verrà	
contattato	mediante	l'indirizzo	di	registrazione.	Gli	aggiornamenti	firmware	sono	gratuiti	per	il	primo	anno	
di	possesso,	salvo	diversamente	dichiarato.	Indirizzare	eventuali	domande	al	rivenditore	o	direttamente	ad	
Apogee al seguente indirizzo:

APOGEE ELECTRONICS CORPORATION, 
1715 Berkeley St. Santa Monica, CA  90404, USA. 
Tel: (310) 584-9394
Fax: (310) 584-9385
Email: support@apogeedigital.com 
Web: http://www.apogeedigital.com

APOGEE	ELECTRONICS	CORPORATION	garantisce	questo	prodotto	essere	privo	di	difetti	nel	materiale	
e	nella	manodopera	in	condizioni	d'uso	normale,	per	un	periodo	di	12	mesi.	La	durata	di	questa	garanzia	
ha	decorrenza	dalla	data	di	vendita	all'acquirente.	Le	unità	rese	per	riparazioni	in	garanzia	ad	Apogee	o	
a un centro di riparazioni in garanzia autorizzato Apogee, saranno riparate o sostituite, a discrezione del 
produttore,	gratuitamente.	
TUTTE	LE	UNITÀ	RESE	AD	APOGEE	O	A	UN	CENTRO	RIPARAZIONI	AUTORIZZATO	APOGEE	
DEVONO	ESSERE	PREPAGATE,	ASSICURATE	E	OPPORTUNAMENTE	CONFEZIONATE,	
PREFERIBILMENTE	NELLA	SCATOLA	ORIGINALE.	Apogee	si	riserva	il	diritto	di	modificare	o	migliorare	
il	progetto	in	qualsiasi	momento	e	senza	preavviso.	Le	modifiche	al	progetto	non	vengono	implementate	
retroattivamente	e	l'inclusione	delle	modifiche	di	progetto	nelle	unità	future	non	implica	la	disponibilità	di	un	
aggiornamento	per	le	unità	esistenti.

Questa garanzia sarà nulla se Apogee determina, a sua sola discrezione aziendale, che il difetto sia il 
risultato	di	abuso,	negligenza,	alterazione	o	tentativo	di	riparazione	eseguito	da	personale	non	autorizzato.	

Le garanzie summenzionate sostituiscono tutte le altre garanzie, esplicite o implicite e Apogee nega 
specificamente	qualsiasi	e	tutte	le	garanzie	implicite	di	commerciabilità	o	di	idoneità	per	uno	scopo	
particolare.	L'acquirente	riconosce	e	accetta	che	in	nessun	caso	la	società	sarà	ritenuta	responsabile	di	
qualsiasi danno speciale, indiretto, incidentale o consequenziale o per lesioni, perdita o danno subito da 
qualsiasi persona o proprietà, che potrebbe risultare dal mancato funzionamento o dal funzionamento non 
corretto	in	qualsiasi	momento	di	questo	prodotto.	

alcuni stati non ammettono l'esclusione o la limitazione delle garanzie implicite o della responsabilità per 
danni incidentali o consequenziali, perciò l'esclusione precedente potrebbe non essere pertinente agli utenti 
di	tali	stati.	Questa	garanzia	fornisce	all'utente	diritti	legali	speciali,	e	l'utente	potrebbe	godere	di	altri	diritti	
che	variano	da	stato	a	stato.	

Informazioni di manutenzione

Duet non contiene componenti che possano essere riparati dall'utente: per la riparazione o l'aggiornamento, 
rivolgersi	a	personale	tecnico	qualificato.	La	garanzia	potrebbe	essere	invalidata	se	l'utente	manomette	i	
componenti	interni.	Per	qualsiasi	domanda	su	quanto	indicato	in	precedenza,	rivolgersi	ad	Apogee.	

Nel caso in cui si desideri aggiornare o riparare l'unità Duet, è necessario rivolgersi ad Apogee prima della 
spedizione	e	ottenere	un	numero	di	autorizzazione	alla	restituzione	(RMA).	Questo	numero	servirà	come	
riferimento	per	l'utente	e	renderà	più	agevole	e	veloce	il	processo	di	restituzione.	Apogee	richiede	che	la	
spedizione	sia	prepagata	e	assicurata,		salvo	diversamente	autorizzato	in	anticipo.	

IMPORTANTE: QUALSIASI SPEDIZIONE NON PREPAGATA O INVIATA SENZA NUMERO DI 
AUTORIZZAZIONE RMA NON SARÀ ACCETTATA. 
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Dichiarazioni di conformità

Questa	periferica	è	conforme	alla	Parte	15	delle	normative	FCC.	Il	funzionamento	è	soggetto	alle	due	
condizioni seguenti: 
1.	 Questa	periferica	non	può	causare	interferenze	dannose
2.		Questa	periferica	deve	accettare	qualsiasi	interferenza	ricevuta,	tra	cui	le	interferenze	che	

potrebbero	causare	un	funzionamento	indesiderato.

Questa apparecchiatura è stata collaudata e trovata conforme ai limiti di una periferica digitale di Classe 
A,	ai	sensi	della	parte	15	delle	normative	FCC.	Questi	limiti	sono	progettati	per	fornire	una	protezione	
ragionevole	contro	le	interferenze	dannose	in	un'installazione	residenziale.	Questa	apparecchiatura	
genera, utilizza e può irradiare energia a frequenza radio e, se non installata e utilizzata secondo il 
manuale	di	istruzioni,	potrebbe	causare	interferenze	dannose	alle	comunicazioni	radio.	Se	questa	
apparecchiatura genera interferenze dannose alla ricezione radio e televisiva, che possono essere 
determinate accendendo e spegnendo l'apparecchiatura, si richiede all'utente di tentare di correggere le 
interferenze adottando una o più delle misure seguenti:

1.		Riorientare	o	riposizionare	l'antenna	ricevente.
2.		 Aumentare	la	distanza	tra	l'apparecchiatura	e	il	ricevitore.
3.		Collegare	l'apparecchiatura	in	una	presa	di	rete	su	un	circuito	diverso	da	quello	in	cui	è	collegato	il	

ricevitore.
4.		Consultare	il	rivenditore	o	un	tecnico	radio/tv	esperto	per	assistenza.

NOTA:	l'uso	di	un	cavo	non	schermato	con	questa	apparecchiatura	è	vietato.
Modifiche	o	manipolazioni	non	esplicitamente	approvate	dal	produttore	responsabile	della	conformità	
potrebbero	invalidare	l'autorizzazione	dell'utente	a	utilizzare	l'apparecchiatura.

Apogee	Electronics	Corporation,	Betty	Bennett,	CEO.

Industry Canada Notice

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.	Cet	appareil	numérique	de	la	classe	B	respecte	toutes	les	exigences	du	Règlement	sur	le	
matérial	brouilleur	du	Canada.

Dichiarazione di conformità  CE

Apogee Electronics Corporation dichiara con il presente documento che il prodotto, Duet, al quale si 
riferisce la presente dichiarazione, è in conformità materiale con gli standard o altri documenti normativi 
seguenti:

	 EN55022:1998,	EN55024:1998	
 
	 EN61000-3-2,	EN61000-3-3,	EN61000-4-2,	EN61000-4-3,	EN61000-4-4,	EN61000-4-5,	 

EN61000-4-6,	EN61000-4-8,	EN61000-4-11

Dichiarazione di conformità – Giappone

Apogee Electronics Corporation dichiara con il presente documento che Duet, al quale si riferisce la 
presente	dichiarazione,	è	in	conformità	materiale	con	lo	standard	VCCI	Classe	B.

Dichiarazione di conformità  Australia/Nuova Zelanda

Apogee Electronics Corporation dichiara con il presente documento che Duet è in conformità materiale 
con	i	requisiti	degli	standard	AN/NZS.
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